
What is Drag And File Gold
Drag And File Gold Gold streamlines and simplifies the work of managing files under Windows 95 and Windows NT. It 
offers several unique functions, such as a directory finder, a duplicate file finder and a DOS command utility.
Drag And File Gold Gold works at several levels of sophistication and integrates with other management and utility 
programs. The result is an uncommon degree of flexibility: Drag And File Gold Gold can be configured to meet your 
needs, your working style, and your experience. When you need more, Drag And File Gold Gold delivers. 
Unlike most other Windows file managers, Drag And File Gold Gold allows you to highlight individual files and tag 
multiple files, which makes possible batch operations on non-contiguous groups of files. 
Drag And File Gold is a special version of Drag And File that also includes our archive management program, Drag And 
Zip.  When Drag And File is combined with Drag And Zip, you can easily manage ZIP, GZ, and TAR files completely 
within Drag And File.  
ZIP,  GZ and TAR files will appear as folders in the directory pane of Drag And File.  The color of these folders is blue 
as compared to yellow for actual directories to make the difference easily noticeable to the user.  Just like with a regular 
folder, you can highlight an archive in the directory pane and the contents of the file will be listed in the file pane.
Extracting files from the archive is just like copying from a directory.  You tag the files that you want to extract and 
choose copy or move.  The files will be extracted to the desired directory.
Drag And File Gold has an additional menu in it's main menu bar.  This menu called "Archive" has commands to create 
an archive, virus scan an archive and "Check Out" an archive.  Check Out will extract the files to a temporary directory 
and allow you to "check them out".  You will be given the option to delete the check out files or make the check out 
directory permanent when you either close Drag And File or check out a new file.
The Create Archive "Zip", Virus Scan and Check Out commands can also be put on Drag And Files toolbar.
These commands are also available when right clicking on the file pane.  Because of limitations in the Windows 95 shell 
context menus, some options are not available for files in an archive.  These options, Create Short Cut, and dragging and 
doping to the desktop cannot be performed on files in an archive.  You will have to first extract the files to a real 
directory before being able to perform these actions.
Drag And File Gold Gold offers a broad range of file management tools:

 Drag-and-drop file move, copy, and delete
 Viewing of all text and most graphics files
 Tree and branch batch operations on all files
· Single click execution of most frequent tasks from a toolbar, including viewing
· Integrated management of Archive (ZIP, TAR, GZ) files
 Separate windows for each drive
 Full configurable hot key control for hands-on keyboard  execution
 Formatting and diskcopying for floppy diskettes
· Full access to the Windows 95 Shell functions like creating shortcuts, Quick View and file properties

Drag And File Gold Gold displays a window complete with toolbar and menu choices for each drive selected. You may 
open up to 12 drive windows simultaneously. 
The entire program can be run from a single small Drivebar which floats unobtrusively on your screen. The Drivebar 
makes complete directory and file information just a mouse click away.

Drag And File Gold Gold includes an Uninstaller to remove the program and changes made during installation. 
Note:  Microsoft Windows' file-handling requirements may make it necessary for you to delete the uninstaller file itself. 

User Help: Guides and Resources
Drag And File Gold Gold is designed to present options and procedures clearly. The window components, including 
icons, graphic and text buttons, and directory tree displays, make evident what to do and how to do it.
Along with ease of use and the ordinary features of file management, Drag And File Gold Gold offers an unusual degree 
of sophistication. Several kinds of resources help users at all levels learn and use these features.
This manual
The Drag And File Gold Gold User's Manual is divided into the following seven sections:

· First Things - installation and program description
· Configuring - setting your preferences
· Using Drag And File Gold Gold - main features
· Managing Files



· Working With Files From More Than One Directory or
Drive

· Working With Archive Files
· DOS Command Utility

On-line help
The on-line help system is available at any time by clicking on the Help menu on the menu bar in the main window. 
Context-sensitive help is also available for most menus and dialog boxes. For information and procedural help specific to 
a screen or menu, click on the Help button.
User help
Canyon Software is committed to producing software that is useful and productive. To help users make full use of Drag 
And File Gold Gold, Canyon Software maintains a technical help line for registered users from 8:30 AM to 5:30 PM 
Pacific Time.

Phone (415) 453-9779
Fax (415) 453-6195
BBS (415) 453-4289
CompuServe Go CANYON
America On Line DanBCan
Internet support@canyonsw.com

Installation
Requirements
Drag And File Gold Gold is designed to run on an IBM PC-running Windows 95 or Windows NT 3. 51 or greater.  The 
program requires 1 megabyte of disk space for a typical installation. 
Installation procedures

1. Power on the computer, load Windows, and open the Program Manager.
2. Insert the Drag And File Gold Gold disk into an appropriate drive.
3. From the Program Manager's File menu, choose Run.
4. In the dialog box, type the designation of the drive in which you inserted the Drag And File Gold Gold program 

disk, followed by "SETUP" and press the Enter key.  If the drive is designated B:, the Run command  would be 
as follows:

B:DFGSETUP
5. At the initial introduction screen choose OK and a dialog box will come up asking you where you want to install 

Drag And File Gold Gold.  The default is C:\DF32.  If you don't want to install to that directory you can choose 
the browse button and choose a different directory to install to.  If you enter a directory name that doesn't exist, 
Drag And File Gold Gold will create that directory.

6. The installation program concludes by opening the newly created Drag And File Gold Gold group window, 
showing the icons representing components of the program. 

Uninstall
To remove Drag And File Gold:

From Windows 95
· Open up the My Computer folder from that folder open up the Control Panel Folder.  From the Control Panel 

Folder choose Add/Remove Programs.  The dialog box that comes up will list the programs that you can 
uninstall.  One of them should be Drag And File Gold for Win 32.  Choose that option and choose Uninstall.

From Windows NT or Windows 95
Run the program DFUN.EXE.  It is in the directory where you installed Drag And File Gold and in the Drag And
File Gold program group..

Note:  Microsoft Windows' file-handling requirements may make it necessary for you to delete the uninstaller file itself. 

Configuring 
Setting Preferences



Drag And File Gold offers several ways to tailor the program to meet individual needs. 
Options/Settings
From the Options menu you access the Fonts and Settings dialog boxes, which allow you to adjust several aspects of the 
program's performance and display.
To change fonts:

1. Select Fonts from the Options menu.
The Fonts dialog box displays. Available fonts are those which are installed under Windows, or under a type 
manager working with Windows.

2. Make whatever changes you wish and click OK.
The changes take effect immediately and remain when you exit the program.

To change Settings:
1. Select Settings from the Options menu.

The Settings dialog box displays.  The Settings dialog box has three pages for configuring Drag And File Gold 
Options. The first page is for general settings.

2. Enter your choices for warnings, multiple windows operations and window appearance, file delete and editor.
Overwrite Warnings. When enabled, these warnings appear when the files you are copying or moving are about
to overwrite files of the same name.   These warnings can always be overridden at copy or move time.
File Delete. When checked, files deleted in Drag And File Gold will be send to the RECYCLE BIN.  When not 
checked, you will have to use an undelete program to recover deleted files.  This option is not available when 
running under Windows NT.
Multiple Window Operations. Drag And File Gold lets you perform operations on tagged files in more than one
window. These choices allow you to specify which operations you would like to perform in multiple windows.
When Copy from multiple windows is checked, Drag And File Gold will perform all file copy operations on the
highlighted file or the tagged files from all open Drag And File Gold windows.
When Move from multiple windows is checked, Drag And File Gold will perform all file move operations on 
the highlighted file or the tagged files from all open Drag And File Gold windows.
When View files from multiple windows is checked, and you choose the view files option from the Drag And 
File Gold tool bar or the "Actions" menu, Drag And File Gold will view the highlighted and tagged files from all
open Drag And File Gold windows.
When View directories from multiple windows is checked, and you choose the view directories option from 
the Drag And File Gold tool bar or the "Actions" menu, Drag And File Gold will open up a view window with 
the listing of all the files in the highlighted and tagged directories  from all open Drag And File Gold windows.
When Drag and drop from multiple windows is checked, all drag and drop operations to other programs 
include the tagged files or highlighted file from all Drag And File Gold windows.  Drag And Drop operations to 
toolbar buttons will depend on the configuration for the action of the particular button.  For example, if you have
Drag And File Gold configured to copy from only the active window, dragging files to the copy button will only 
work on the active window no matter what you have configured for drag and drop.
When Zip file from multiple windows is checked and you click on the zip button on the toolbar, the highlighted
file or the tagged files in all the open Drag And File Gold windows will be put in the resulting Zip file.  
Save Window Layout:  Checking this option will have Drag And File Gold save the location and the current 
directories of all open Drag And File Gold windows when you exit Drag And File Gold.  Running Drag And File
Gold again will open all the windows of the previous session and have them displaying the same directories as 
the previous session.  To save the layout of multiple Drag And File Gold windows exit with "File/Close All DF 
Windows".  
Window Appearance: These choices follow the pattern for Microsoft Windows: cascaded windows are 
overlapped slightly, and tiled windows are fully visible.
Editor:  Enter your editor of choice in this field and you can edit a highlighted file when you choose the edit file
option.
Archive Management: When Show Archives as Folders is checked, ZIP, TAR and GZ files will appear on the 
directory tree as folders.  They will be colored blue to differentiate them from regular directory folders.  When a 
archive folder is highlighted on the tree, the contents of the archive will be displayed in the file pane.

3. In the drives page you can configure the drives that are available to Drag And File Gold.  This is particularly 
useful on networks where you might want to limit the drives available to different users.  The settings in this 
dialog box will be reflected in both Drag And File Gold and the Drag And File Gold Drive Bar.



Select the drives that you want to have available.  To make drive selection easier, there are check boxes where 
you can turn on or off the different drive types.  Drives that have been selected will be displayed below the drive 
list box.

4.  You can turn on Drag And File Gold's DOS Command Line by choosing Show DOS Command Line from the 
Options menu.  In this page you can set the DOS command Line defaults.
DOS In Window:  You can run most DOS commands with the SmilerShell and can choose to have these 
commands run full screen or in a DOS window.  The default is to run the commands in a DOS Window.
Inactive DOS Windows Stay Visible:  This options determines whether the DOS windows will stay around or 
close after DOS commands are run.  If you choose to have the DOS windows stay around you can easily close 
them all at once by pressing Ctrl+Shift+K from the keyboard.
Insert Mode: Use this to toggle between Insert or Overtype mode
Use Comspec: By default, the DOS command utility, will send all DOS commands to the standard DOS 
command processor, COMMAND.COM.  Some programs like 4DOS, NDOS and others use a different 
command processor.  They specify the command processor in your CONFIG.SYS file with the statement 
"comspec=".  If you choose to use the command processor specified in your CONFIG.SYS file, see that this item
is checked.  Inorder to see this option take effect you will have to restart Drag And File Gold.  This is only 
necessary with the Use Comspec option.

5. You can modify how Drag And File works with archive files by choosing the Drag And Zip tab.
Hide Icon Under Windows NT with Program Manager, Drag And Zip runs as an icon at the lower left of you 
screen.  This option will hide the icon from view.  Under Windows 95, it won't do anything.

. Icon Always Visible Checking this option will make Drag And Zip's icon visible at all times.  This is not 
necessary in Windows 95 or if you are running Drag And Zip with Fileman Launcher, as Fileman Launcher will 
always uncover DZ's icon when you are working in your file manager.
Icon Stays Where Last Put Checking this option will have Drag And Zip remember the position of its icon 
when you last ran it.  This is not necessary if you are running DZ with Fileman Launcher or if you're running 
Drag And Zip under Windows 95.
PKZIP Version 2 or Greater It's important that this option be checked if you are running with PKZIP version 
2.04, and that it not be checked if you are running with PKZIP version 1.1.  That way Drag And Zip can pass the
proper commands to PKZIP when it is running it.  No other versions of PKZIP are currently supported.  When 
you choose your PKZIP directory, Drag And Zip will try to determine this automatically.
Output Directory You have two choices of the default output directory that Drag And Zip will enter into the zip
dialogs.  One is the current directory, which is the directory that you dragged the files from.  The other is the 
directory that you used the last time that you used Drag And Zip.
PKZIP Location This should contain the directory where your copies of PKZIP and PKUNZIP are.  It is not 
necessary to fill this out if you are using the built-in zipping and unzipping.  You will need to fill this out if you 
want to make self-extracting zip files and ZIP2EXE is not on your path.  When this field is active, you can use 
the browse button to find the PKZIP directory.
LHA Location This should contain the directory where your copy of LHA.EXE is. When this field is active, you
can use the browse button to find the LHA directory.
Path For Temporary Files Drag And Zip normally creates temporary files and temporary directories in it home 
directory.  This may not be possible if you are running Drag And Zip from a network and you don't have write 
access to the DZ home directory.  For conditions like this, you can specify a directory where Drag And Zip can 
store temporary files.
WWW Browser Zip View has been made to work with many World Wide Web browsers.  Make sure you have 
the full path including the file name of the browser entered in this field.  If it is, Zip View will run automatically 
whenever you bring a GZ, ZIP, TAR or LZH file from the net. 
Anti Virus Program By default, Drag And Zip will use its built-in virus scanning program.  However you can 
also have it run your copy of  Scan 95, Scan or Norton Anti Virus.  Choose the program that you want to run 
from the combo box.

If you have our viewing program Drag And View installed, you will also be able to configure it with a Drag And View 
tab.

Configure Toolbar
Drag And File Gold's button toolbar is very easily modified allowing you to add and delete different buttons.  Programs 
can also be added to toolbar buttons.  All toolbar buttons can be configured to user Alt or Ctrl key combinations as hot 



keys.  Alt hot keys are shown in the lower right of the button as black on gray.  Ctrl hot keys are shown as white on black.
There is also an option to completely hide the toolbar.  If the toolbar is hidden, the configured hot keys are still active.
To modify the toolbar:

1. Choose Customize Toolbar from the Options menu.
The Toolbar Customize dialog appears:

In the list box on the left appear the available button choices.  The top two entries are SEPARATOR and NEW 
PROGRAM.  SEPARATOR adds a space between two buttons.  NEW PROGRAM allows you to install a program as
a button choice.  In the list box on the right appear the buttons that are currently part of the toolbar along with their 
hot keys.  

To add a new button
1 Select the position in the Toolbar buttons list box where you want the button to appear.  The new button will 

appear before the selected button.  You can also drag buttons in the Toolbar buttons list box to modify their 
position.

2. Select the button that you want to add from the Available buttons list box.  You can also choose SEPARATOR 
or NEW PROGRAM.  If a command button is already in the Toolbar buttons list box, it won't be in the 
Available buttons list.

3. Choose Add or drag the button to the right hand list box.  The button will be added.
To remove a button

1. Select the button that you want to remove from the Toolbar buttons list box.  Click on Remove or drag the button
to the left hand list box.  The button will be removed.

To add a program
1. Select NEW PROGRAM and choose Add.  The Add Program dialog will appear.

2. Browse through the directories and files and pick the program that you want to associate with the button.  If you 
want the file that's currently highlighted to be launched with the program check the Launch Highlighted File 
With Program box.  When the mouse cursor is over any of the toolbar buttons, a little window will come up 
saying what the button does.  You can enter a custom button description in the Button Description field.  If no
description is entered, the program name will be used.

3. Choose OK and the button will be added to the Toolbar buttons list box.  If the program has an embedded icon 
like most Windows programs, that icon will be placed on the button.

To modify a program button
1. Highlight the button in the Toolbar buttons list box.  Choose the Program button and the Add Program dialog 

will appear.  Follow the directions for adding a program.
To add a filter set

1. Select  the Filter Set button and then click on the Add button.  The Add Filter Set dialog will appear.

2. The available filters are shown in a list box.  When you highlight a particular filter, that filter's file spec and 
other parameters are shown below.

3. Choose OK and a filter set button will be added to the Toolbar buttons list box.  The name of the filter set will 
appear in the tool tip window when you place the cursor over the button.

To add or change a button hot key
1. Highlight the button whose hot key you want to change or add.  Select the letter of the hot key that you want to 

use from the drop down list box in the lower right of the Customize Toolbar dialog box.  Choose Alt or Ctrl if 
you want the hot key to use the Alt key or the Ctrl key.  

When you are finished making changes to the toolbar, choose OK.  All changes will be saved and windows updated.  If 
you choose a hotkey that is already in use, you will be warned before saving the new hot key.

Drag And File Gold Drivebar
About the Drivebar
Though small and unobtrusive, the Drag And File Gold Drivebar can provide access to all your Drag And File Gold 
functions.
The Drivebar consists of a floating bar containing buttons which represent your drives, removable and fixed drives, local 
and networked, and a control bar. Click on a drive button to open a new drive window. Click on the control bar to open a 
menu with choices to control the Drivebar display and to close all open Drag And File Gold windows.

The DF Drivebar normally floats in the foreground, above whatever application is current.



Using the Drivebar
To activate the Drivebar, open the Drag And File Gold group window from Program Manager and click on the DF 
Drivebar icon. 

Configuring the Drivebar
The  Drivebar can be altered to fit your needs. 
To configure the Drivebar:

1. Click on the control bar in the upper left corner of the DF Drivebar icon bar.
The control menu appears.

2. Click on Display Vertically (or Display Horizontally) to select the configuration other than the one 
currently in effect.

3. Click on Always Visible to make the Drivebar appear on top of other programs.
4. Click on Close All Drag And File Gold Windows to close all open Drag And File Gold drive 

windows, but leave the Drivebar icon visible.
5. Click on other choices as needed to Move, Close, open a Help window, or to see information about the Drivebar.

Using Drag And File Gold
Drag And File Gold Main Window
The Drag And File Gold window is divided into several functional and information sections. Drag And File Gold can 
open up to twelve windows simultaneously.

The menu bar contains drop down menus. They are accessible with a mouse or directly from the keyboard by using the 
Alt key in combination with the underlined letter or arrow keys.
The information sections contain data about the drive currently displayed, number of directories on this drive, the space 
remaining on the drive, the  files in the selected directory, and their total size.
The drive buttons allow you to choose which drive information the open window displays. Double clicking on the icon of 
the currently displayed drive opens a second window displaying that drive.
The lower half of the window is divided into two panes: information in the left pane concerns directories, and information
about files appears in the right pane.
Choosing files and directories
Drag And File Gold, slightly differently from Microsoft Windows File Manager,  and Windows 95 Explorer.
Drag And File Gold marks files and directories by highlighting, tagging, and dotting.

 Highlight files and directories by left clicking on them with the mouse, or by using the arrow keys to move the 
highlight bar up or down over a listing. Only one directory or file can be highlighted at a time. Operations like 
Copy or Move can be performed on a highlighted file by clicking the appropriate tool, or by using drop down 
menus or keyboard shortcut keys. If any files are tagged, highlighting is ignored.

· Tag and untag files or directories by several methods:
· Ctrl+Left Mouse Button will tag or untag a file.  A tagged file has a red arrow to its left.
· Ctrl+Left Arrow or Slash tag all files or directories
· Right arrow to tag; left arrow to untag.  ( This method is not available when viewing filenames only )
· Spacebar and Ctrl-Right click to toggle tagging on or off.
· Ctrl+Right Arrow or Ctrl+Slash untag all files or directories
· Dots mark files which have been copied. Dotted files may be reselected as a group for other operations.

Menu Bar
The menu bar contains the headers for the main drop down menus. Most menus include information about shortcut key 
combinations to activate commands from the keyboard.
Drag And File Gold includes in its menu bar extensions—drop down menus inserted in the File Manager's menu bar by 
utility and other programs. 
Drive bar
The drive bar includes buttons that represent all accessible drives.  Click on a drive button to change to that particular 
drive.  Double click on a drive button to open a new Drag And File Gold window for that drive.  Additionally, files can 
be dragged to the drive buttons for copying or moving.  In Windows 95 you can right click on a drive button to bring up a



context menu. From this context menu you can access the drives sharing, format the drive, create a shortcut or access the 
drives properties
Toolbar
The toolbar displays a series of buttons that activate tools or shortcuts.
Directory pane
The directory pane displays, in a tree format, all directories and subdirectories of the currently selected drive.
File pane
The file pane displays a list of the files and their attributes contained within the currently selected directory or 
subdirectory.  .  If you are viewing all file details (the default view) there will be a Caption Bar over the file listing.

You can drag the boarders of some of the sections to resize the columns.  When you click on the heading buttons you will
sort the file list in the order of the button legend.  One click will sort ascending.  The second click will sort descending.

Type to File/Directory function
To locate a specific directory or file, when the appropriate pane is active, start typing the name of the directory or file. 
Your typing appears in a small window that opens over the directory count in the lower left corner of the window, 
beneath the directory pane. As you type, the highlight bar will move to the directory or file which most closely 
approximates your typing.

Managing Files and Archives 
Drag and drop functions
Drag And File Gold uses all the mouse conventions associated with Microsoft Windows programs.
When you drag and drop files and directories with the left mouse button to a directory or drive button, a dialog box opens.
Using options in the dialog box you can specify a Copy or Move operation, the name of the file or directory, and use a 
browse feature to specify the path.
When "Drag and drop from multiple windows" is turned on in the settings dialog, all drag and drop operations will use 
the highlighted or tagged files in all open Drag And File Gold windows.
Files or directories can also be dragged to toolbar buttons.
When you drag and drop files and directories with the right mouse button under Windows 95, a context menu will pop up 
allowing you to copy or move the files or create a shortcut to the files

Toolbar functions
Drag And File Gold's toolbar contains buttons which make the most common file management tasks easily accessible.  
Functions and programs can be added to or deleted from the toolbar by choosing Options/Modify Toolbar.

Using The Keyboard
Drag And File Gold allows you to access most functions directly from the keyboard as well as use the mouse to select 
functions from a drop down menu.  All buttons can have Alt or Ctrl key combinations assigned to them.

File Menu
Use commands in the File menu to perform the most common functions used to manage your files and directories.  If the 
command has a button associated with it, then this command can be put on the toolbar.


